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RTPView Project Program 
Hardware Setup 

 ● No physical I/O hardware is required to perform this setup example.  You are free 
to use either an RTP target node configured in a previous setup example, or the 
NetArrays built-in Simulator. 

NetArrays Project 
 ● Open the NetArrays program “My_first.dbn” that was created in the Example 

“NetArrays Project Development”.  If you have not previously created this program, 
do so now  Click on File and select Open Project… 

 

 ● Select the My_first.dbn and click Open. 
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 ● In the NetArrays Device menu, select Select and choose the target node you 
are using to run this example, or the local Simulator.  In the NetArrays Device 
menu, select Download Project to download and run your project on the selected 
device. 

 

 ● Enter rtp for Download Password and type rtp and select OK. 

 

 ● When prompted select Yes for Do you want to overwrite? 

 

 ● Examine the Output Window to confirm that the download was successful.  This 
project program must remain running in the target node or Simulator while you 
complete the rest of this setup example. 
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Examine Output 
Window 

Download 
complete 
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RTPView Project 
The RTPView will contain a Fader and a Key Switch that write data to the NetArrays 
project program, and a Tank, a Temperature Gauge, and A Trend object that read data 
from the NetArrays project program. 

 ● In the NetArrays toolbar, click the  button to launch RTPView. 

 ● In RTPView, click on the  (New Project) button to begin a new project. 

 

 ● Select No to the question: Project has been modified. Save Changes? 

 

 

New Project 
Button 

Edit Box Button 

Picture Button

Gauge Button 

Object Size 

Position

Trend Button 

Group Button 

Run 
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Fader 

The Fader consists of a static Scale picture object, a Pointer picture object that drives a 
variable in the NetArrays project program, and an Edit Box object that reads the Fader 
position form a variable in the NetArrays project program. 

Fader Scale 

 ● Click on the  (Picture) button in the Palette toolbar.  Move the cursor near the 
upper left corner of the page and click the mouse button.  A dark gray rectangle will 
appear on the page. 

 ● Right-click on the rectangle and select Object Properties from the menu.  This will 
display the Object Properties dialog. 

  

 ● Click on the Image tab of the Properties dialog.  From the Category list, select 
Scales.  From the list of Pictures, select Scale2(0-2-50).bmp.  The picture will 
appear in the Preview frame. 

  
 

Select 
Scale2(0-2-50).bmp 

Select Scales 
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 ● Click the OK button to close the Properties dialog. 

 ● Select the Scale object, press and hold the Shift key, and use the arrow keys to 
adjust the size of the Scale to 20 x 200 pixels.  Release the Shift key and use the 
arrow keys to position the Scale at coordinates 60, 30.  It should look like the 
following example. 

   

Fader Pointer 

 ● Click on the  (Picture) button in the Palette toolbar.  Move the cursor near the 
top of the Scale and click the mouse button.  A dark gray rectangle will appear over 
the scale. 

 ● Right-click on the rectangle and select Object Properties from the menu. 

 ● In the General tab of the Properties dialog, select Read/Write as the Data 
property.  Check the check box to the left of Repeat write while mouse button is 
pressed.  RTPView will write the output of this object as it is being moved. 

  

 ● Click on the Image tab of the Properties dialog.  From the list of categories, select 
Misc.  From the list of Pictures, select needleBlue.bmp.  The picture will appear in 
the Preview frame. 

Select Read/Write 

Check 
Repeat Box 
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 ● Click the OK button to close the Properties dialog. 

 ● Select the Pointer object, press and hold the Shift key, and use the arrow keys to 
adjust the size of the Pointer to 30 x 15 pixels.  Release the Shift key and use the 
arrow keys to position the Pointer at coordinates 36, 26.  This positions the Pointer 
at the top of the Scale. 

 ● Right-click on the Pointer object again and select Object Properties from the 
menu. 

 ● Click on the Motion tab of the Properties dialog.  Check the Enable checkbox to 
enable motion control for the object.  Select Up as the Move property.  Leave the 
Min Value at 0 and the Max Value at 100. 

  

 ● Click the OK button to close the Properties dialog. 

 ● Drag the bottom anchor point of the Pointer down to just below the bottom of the 
Scale and release it.  This determines the motion length for the object. 

Check Enable 

Select Up 

Select 
needleBlue.bmp 

Select Misc 
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Fader Output Edit Box 

 ● Click on the  (Edit Box) button in the Palette toolbar.  Move the cursor under the 
bottom of the Scale and click the mouse button.  A light gray rectangle will appear 
below the Scale. 

 ● Right-click on the rectangle and select Object Properties from the menu. 

 ● In the General tab of the Properties dialog, select Read as the Data property. 

  

 ● Click on the Text tab.  Press the Font button and change the Font settings to Arial, 
Bold, 12.  Click the OK button the close the Font dialog. 

 ● Click on the Color button and select Red for the text color.  Click the OK button the 
close the Color dialog. 

 ● Select Center for the Alignment and Raised for the Border type. 

Stretch Pointer 
Down to Here 

Select Read 
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 ● Click on the Format tab.  Select Float as the text Format, and 0 for the number of 
Decimal Places.  Click the OK button the close the Object Properties dialog. 

  

 ● Right-click on the Edit Box object and select Data Properties from the menu. 

 ● Click on the Tag column and select Fader from the list of tag names.  Click the OK 
button to close the Data Properties dialog.  The Device will automatically be set to 
the device with the downloaded program. 

Select Red for Color

Select Arial, Bold, 12 

Select Center 

Select Raised 
for Border 

Select Float 

Change to 0
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 ● Resize the Edit Box to about 50 x 20 pixels and position it under the center of the 
fader scale.  The completed Fader assembly should look like the example shown 
below. 

  

 

Select Fader
as the Tag 

Resize and 
Position Here
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Key Switch 

The Key Switch is a button Picture object that turns the Tank Mixer on and off. 

 ● Click on the  (Picture) button in the Palette toolbar.  Move the cursor to the right 
of the Fader and click the mouse button.  A dark gray rectangle will appear on the 
page. 

 ● Right-click on the rectangle and select Object Properties from the menu. 

 ● In the General tab of the Properties dialog, select Read/Write as the Data property.  
This object will write a Boolean value to the NetArrays project. 

  

 ● Click on the Image tab.  Select Buttons as the Category. Click on the scroll down 
arrow just to the right of the Pictures until the 8 Slot with key turned 
vertical.bmp as the Picture.  The bitmap of the key switch will appear in the 
Preview frame. 

  

 ● Click on the scroll down arrow just to the right of the Preview frame.  The caption 
Image #1 will appear in the Preview frame.  Select 8 Slot with key turned 

Select Read/Write

Select Buttons 

Select 8 Slot with 
key turned 
vertical.bmp 
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horizontal.bmp as the Picture.  The second bitmap of the key switch will appear in 
the Preview frame. 

 ● Change the entry in the Value field below the Preview to 1. 

  

 ● Click on the Button tab.  Check the Enable checkbox to allow the picture object to 
function as a button.  Select Toggle as the button Type.  Each time the object is 
clicked, its output changes state. 

  

 ● Click on the OK button to close the Object Properties dialog. 

 ● Select the key switch object and resize it to about 52 x 52 pixels.  Move the object 
to coordinates 172, 25.  It should look like the example shown below. 

   
 ● Right-click on the Key switch object and select Data Properties from the menu. 

Click Here 

Select 8 Slot with 
key turned 
horizontal.bmp 

Enter 1 

Check Enable

Select Toggle
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 ● Click on the Tag column and select Key from the list of tag names.  Click the OK 
button to close the Data Properties dialog. 

  
 

Select Key
as Tag 
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Tank 

The Tank consists of a static Tank picture image, and Cutaway fill picture, and a Mixer 
picture image. 
 
Tank Image 

 ● Click on the  (Picture) button in the Palette toolbar.  Move the cursor to the right 
of the Key Switch and click the mouse button.  A dark gray rectangle will appear on 
the page. 

 ● Right-click on the rectangle and select Object Properties from the menu. 

 ● Click on the Image tab.  Select Tanks as the Category, and Tank 22.bmp as the 
Picture.  The bitmap of the tank will appear in the Preview frame.  Click the OK 
button to close the Object Properties dialog. 

  

 ● Select the Tank object, press and hold the Shift key, and use the arrow keys to 
adjust the size of the Tank to 100 x 155 pixels.  Release the Shift key and use the 
arrow keys to position the Tank at coordinates 230, 70.  The Tank should look like 
the example shown below. 

   
 

Select Tanks 

Select Tank 22.bmp 
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Tank Cutaway 

 ● Click on the  button in the Palette toolbar.  Move the cursor over the Tank object 
and click the mouse button.  A dark gray rectangle will appear over the Tank. 

 ● Right-click on the rectangle and select Object Properties from the menu. 

 ● In the General tab of the Properties dialog, select Read as the Data property.  This 
object will be controlled by a floating-point value from the NetArrays project. 

 ● Click on the BackColor button.  Select Dark Gray as the Background color.  Click 
on the OK button to close the Color dialog.  This will be the color of an empty tank 
cutaway. 

  

 ● Click on the Image tab.  Select Tank Cutaways as the Category, and Jagged cut-
away 3.bmp as the Picture.  The bitmap of the cutaway will appear in the Preview 
frame. 

  

 ● Click on the Fill tab.  Check the Enable checkbox.   Select Up as the Fill function.  
Leave the Min Value and Max. Value fields at their default values (0 and 100).  

Select Read 

Select Tank 
Cutaways 

Select Jagged 
cut-away 3.bmp

Select Dark 
Gray as the 
Background 
Color 
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Click on the Fill Color button and select Blue as the fill color.  Click on the OK 
button to close the Color dialog.  Click on the Display Value None radio button. 

  

 ● Click on the OK button to close the Object Properties dialog. 

 ● Right-click on the cutaway object and select Data Properties from the menu. 

 ● Click on the Tag column and select TankLevel from the list of tag names.  Click 
the OK button to close the Data Properties dialog. 

  

 ● Select the cutaway and resize it to about 85 x 100 pixels.  Move the object so that it 
overlays the Tank as shown in the example below. 

Check Enable 

Select Up 

Select TankLevel
as the Tag 

Select Blue 
for Fill Color 

Select None 



RTPView Project Program Example 

 19 

   

Tank Mixer 

 ● Click on the  button in the Palette toolbar.  Move the cursor over the Tank object 
and click the mouse button.  A dark gray rectangle will appear over the Tank. 

 ● Right-click on the rectangle and select Object Properties from the menu. 

 ● In the General tab of the Properties dialog, select Read as the Data property.  The 
image displayed will be controlled by the Waveform Generator in the NetArrays 
project. 

  

 ● Click on the Image tab.  Select Mixers as the Category, and Magnetic mixer 
1.bmp as the Picture.  The bitmap of the mixer will appear in the Preview frame. 

Resize and 
Position Over 
Tank 

Select Read 
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 ● Click on the scroll down arrow just to the right of the Preview frame.  The caption 
Image #1 will appear in the Preview frame.  Select Magnetic mixer 2.bmp as the 
Picture.  The second mixer bitmap will appear in the Preview frame. 

 ● Change the entry in the Value field below the Preview to 1. 

  

 ● Click on the scroll down arrow again.  The caption Image #2 will appear in the 
Preview frame.  Select Magnetic mixer 3.bmp as the Picture.  The third mixer 
bitmap will appear in the Preview frame. 

 ● Change the entry in the Value field to 2. 

Select Mixers 

Select Magnetic 
mixer 1.bmp 

Select Magnetic 
mixer 2.bmp 

Click Here

Enter 1 
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 ● Click on the scroll down arrow again.  The caption Image #3 will appear in the 
Preview frame.  Select Magnetic mixer 4.bmp as the Picture.  The last mixer 
bitmap will appear in the Preview frame. 

 ● Change the entry in the Value field to 3. 

  

 ● Click on the OK button to close the Object Properties dialog. 

 ● Select the mixer object and resize it to about 30 x 145 pixels.  Move the object so 
that it appears over the Tank as shown in the following example. 

Select Magnetic 
mixer 3.bmp 

Click Here

Enter 2 

Select Magnetic 
mixer 4.bmp 

Click Here

Enter 3 
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 ● Right-click on the mixer object and select Data Properties from the menu. 

 ● Click on the Tag column and select Mixer from the list of tag names.  Click the OK 
button to close the Data Properties dialog. 

  

Resize and Position 
Over Tank 

Select Mixer as Tag 
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Temperature Gauge 

The Temperature Gauge displays both Celsius and Fahrenheit temperatures derived 
from the Fader output in the RTPView project.  It is created from a single Gauge object. 

 ● Click on the  (Gauge) button in the Palette toolbar.  Move the cursor to the right 
of the Tank and click the mouse button.  The Gauge object will appear on the page. 

 ● Select the Gauge object, press and hold the Shift key, and use the arrow keys to 
adjust the size of the Scale to 300 x 260 pixels. 

  

 ● Right-click on the Gauge and select Object Properties from the menu. 

 ● In the Annulars tab of the Properties dialog, increase the # of Annulars to 2.  The 
Annular ID and Scale ID fields should indicate 1.  Click on the Color button and 
select Blue as the color of the first annular.  Click on the OK button to close the 
Color dialog.  Change the Angular Dimensions Start parameter to -45 degrees 
and the Stop parameter to 225 degrees.  Leave the Radius and Width 
Dimensions at the default values (100 and 4). 

  

Change to 2 

Select Blue as Color 

Resize to 300 x 260 

Change to -45 

Change to 225 
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 ● Change the Annular ID to 2 and the Scale ID to 2 to select the second annular. 

 ● Click on the Color button and select Green as the color of the second annular.  
Click on the OK button to close the Color dialog.  Change the Angular 
Dimensions Start to -45 degrees and the Stop to 225 degrees.  Change the 
Radius Dimension to 105.  Leave the Width Dimension at the default value (4). 

  

 ● Click on the Background tab of the Properties dialog.  Click on the Color button 
and select White as the background color.  Click OK to close the Color dialog.  
Leave the Border parameters at the default values (None). 

  

 ● Click on the Digital tab of the Properties dialog.  Un-check the Enable checkbox to 
disable the digital value display. 

Change to 2 

Select Green 
as Color 

Change to -45 

Change to 225 

Change to 105 

Select White as Color 
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 ● Click on the Needle tab of the Properties dialog.  Un-check the Write data 
checkbox. This object will be reading data.  Change the Length to 110 pixels and 
the Width to 6 pixels. 

  

 ● Click on the Scales tab of the Properties dialog.  Increase the # of Scales to 2.  
The Scale ID field should indicate 1.  Enter the value -40 into the Limits Minimum 
field.  Leave the Limits Maximum field at its default value (100).  Leave the 
Direction setting at Clockwise.  Change the Start Angle to -45 degrees and the 
Stop Angle to 225 degrees.  Leave the Horizontal and Vertical Center Positions 
at the default settings (150 and 150). 

Un-Check Enable 

Un-Check Write data
Change to 110 

Change to 6 
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 ● Change the Scale ID to 2 to select the second scale. 

 ● Enter the value -40 into the Limits Minimum field.  Enter the value 212 into the 
Limits Maximum field.  Leave the Direction setting at Clockwise.  Change the 
Start Angle to -45 degrees and the Stop Angle to 225 degrees.  Leave the 
Horizontal and Vertical Center Positions at the default settings (150 and 150). 

  

 ● Click on the Ticks tab of the Properties dialog.  Increase the # of Ticks to 2.  The 
Tick ID and Scale ID fields should indicate 1.  Check the Labels checkbox.  
Change the label Position to -8.  Click the Font button and change the Size to 9.  
Click OK to close the Font dialog.  Click on the Color button and select Blue as the 
color of the Ticks.  Click OK to close the Color dialog 

 ● Change the Start Range to -40.  Leave the Stop Range and Delta at their default 
values (100 and 10).  Leave the Length Dimension at the default value (-10).  
Change the Width Dimension to 2. 

Change to 2
Enter -40 

Enter -45 
Change to 225

Enter -40 Enter 212 

Enter -45 
Change to 225

Change to 2
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 ● Change the Tick ID to 2 and the Scale ID to 2.  Check the Labels checkbox.  
Change the label Position to 10.  Click the Font button and change the Size to 9.  
Click OK to close the Font dialog.  Click on the Color button and select Green as 
the color of the Ticks.  Click OK to close the Color dialog 

 ● Change the Start Range to -40.  Change the Stop Range to 212.  Change the 
Delta value to 20.  Change the Length Dimension to 10 and the Width Dimension 
to 2. 

  

 ● Click on the OK button to close the Object Properties dialog. 

 ● The temperature gauge should look like the example shown below.  Select the 
object and reposition it to coordinates 350, 5. 

Change to 2 

Check Box 

Change to -8 

Change Size to 9 

Change Color 
to Blue 

Change to -40 

Change to 2 

Change to 2 Check Box 

Change to 10 Change Size to 9 

Change Color 
to Green Change to -40 

Change to 2 

Change to 10 
Change to 212 

Change to 20 
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 ● Right-click on the Temperature Gauge object and select Data Properties from the 
menu. 

 ● Click on the Tag column and select Celsius from the list of tag names.  Click the 
OK button to close the Data Properties dialog. 

  

 

Select Celsius
as Tag 
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Trend 

The Trend object will plot the output of the Fader and the Tank fill level.  It consists of a 
single Trend object. 
 

 ● Click on the  (Trend) button in the Palette toolbar.  Move the cursor below the 
other objects and click the mouse button.  The Trend object will appear on the 
page. 

 

 ● Right-click on the Trend and select Object Properties from the menu. 

 ● Select Fader as the Tagname in the first row.  Select TankLevel as the Tagname 
in the second row.  Leave the Min, Max, Scale, and Offset entries at the default 
values.  (Both of these variables range from 0 to 100.) 

  

 ● Click on the Frame tab.  Select Bumped as the Border type.  Click on the 
Background Color button and select White.  Click the OK button to close the 
Color dialog.  Click the OK button to close the Object Properties dialog. 

Select Fader 
as Tag 

Select TankLevel
as Tag 
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Page Properties 

 ● Right-click on any empty space within the page and select Data Properties from 
the menu. 

 ● Enter the value 100 in the Update Rate (ms) field.  This will speed up the 
execution rate and provide smother motion of the objects.  Click on the OK button 
to close Page Properties. 

  

Enter 100 

Select White as 
Background Color 

Select 
Bumped 



RTPView Project Program Example 

 31 

This completes the RTPView project.  Save the project by clicking on File and select 
Save Project as…  Navigate to the RTPView directory, type in a name (such as Test), 
and click Save. 

 

 

Your project should look like the example below. 
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Verification 
Now that the RTPView project is completed, we will now run the project. 

 ● Click on the  (Run) button in the toolbar. 

 ● Click on the Fader pointer and drag it up to mid scale and release it.  Observe that 
the Tank appears to fill to the same level and that the Temperature Gauge needle 
moves to mid scale.  Also observe that the Trend object plots the values of both the 
Fader output and the level in the Tank. 

 ● Click on the Key switch and the Mixer will appear to start running. 

 ● Move the Fader pointer to any other position on the scale. 

 ● If any of the objects do not behave as expected, stop the project and recheck the 
configuration of the object’s properties. 

 

 
 
 
Congratulations!  You have successfully completed and run an RTPView project 
program. 
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Including Your Own Images in RTPView 
The previous examples used only picture images that were supplied with RTPView.  In 
addition to the included images, you can add any of your own bitmap images into your 
RTPView project.  All you have to do is save your bitmap in one of the RTPView/Picture 
directories, or create your own category directory.  However, there are some important 
issues to consider when you adding your own picture images. 
 
If you look through the Bitmap images in the RTP NetSuite\RTPView\Pictures directory, 
you will notice that all the bitmap files are about 150 pixels square or smaller.  They may 
be stretched or compressed as required in the RTPView page. 
 
All images are assigned a Mask Color.  RTPView monitors each pixel of the masked 
portion of the image and replaces it with the appropriate pixel from behind the image.  For 
example, in the Tank Cutaway used in the previous example, the masked area was 
replaced with areas of the Tank image. 
 

  

The mask color must not be a color that is part of the displayed image.  Note that the 
supplies bitmap files use purple as the mask color.  This particular color is not part of the 
intended display.  The default mask color assigned by RTPView is the color of the upper 
leftmost pixel in the bitmap.  You can change the selected mask color by clicking on color 
in the Image Preview of the Object Properties dialog.  The selected mask color is 
displayed in the MC box below the Preview. 
 
When creating a bitmap file, crop the image to remove as much blank background as 
possible.  This will greatly reduce the size of the bitmap file. 
 
After cropping, change the color of the upper-left pixel in the bitmap image.  For example, 
you could change it from white to purple as shown in the figure on the next page.  The 
purple (or other color) pixel will then become the default mask color when the picture 
object is placed onto the RTPView page. 
 
Note that if the bitmap is large, it will be severely compressed in the Image Preview, and 
it may be difficult to select another mask color from the Preview. 
 

Mask Color 

Masked Area
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When using “line art” drawings (for example, thin black lines on a large solid 
background), do not select the background as the mask color.  Use another color, which 
is not part of the line art drawing, as the mask color. 
 
When using photographic images, make sure the mask color does not occur anywhere 
else in the image.  This will create unintended small holes in the image. 
 
 
 
 
 
 

 
 
 

Crop Image to 
Reduce Size 

Detail of Upper 
Left Corner 


